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Reference to the whole or to part of this volume should be made as follows: 
Print citation for Chapter 1:
Shipboard Scientific Party, 2003. Leg 204 summary. In Tréhu, A.M., Bohrmann, G., Rack, F.R., Torres, 
M.E., et al., Proc. ODP, Init. Repts., 204: College Station TX (Ocean Drilling Program), 1–75.

CD-ROM volume citation:
Tréhu, A.M., Bohrmann, G., Rack, F.R., Torres, M.E., et al., 2003. Proc. ODP, Init. Repts., 204 [CD-
ROM]. Available from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-
9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2003. Site 1244. In Tréhu, A.M., Bohrmann, G., Rack, F.R., Torres, M.E., et 
al., Proc. ODP, Init. Repts., 204, 1–132 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M 
University, College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for 
available volumes and Web citation formats. 

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.

The printing date of this volume: November 2003

The mailing dates of recent Proceedings of the Ocean Drilling Program:

Volume 201 (Initial Reports): May 2003
Volume 202 (Initial Reports): October 2003
Volume 203 (Initial Reports): June 2003
Volume 177 (Scientific Results): March 2003
Volume 183 (Scientific Results): June 2003
Volume 186 (Scientific Results): October 2003

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:
Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 

TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

Some close-up photographs of very dark cores have been tonally enhanced to better illustrate 
particular features of interest.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

The cover photograph shows a sample of gas hydrate recovered from 2.69 meters below seafloor near 
the summit of Hydrate Ridge during Leg 204 (Sample 204-1250D-1H-CC, 12–14 cm). It illustrates one 
of the many different types of hydrate fabric observed during Leg 204. In this sample, horizontal 
layering probably reflects in situ hydrate formation parallel to the bedding. Vertical sediment-filled 
cracks likely reflect disruption caused by drilling. The photograph is by ODP Photographer John Beck.

http://gmt.soest.hawaii.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 

coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 18 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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OCEAN DRILLING PROGRAM*
National Science Foundation
4201 Wilson Boulevard
Arlington VA 22230, USA
Tel: (703) 306-1581; Fax: (703) 306-0390
Web site: www.nsf.gov

MEMBER ORGANIZATIONS OF THE JOINT OCEANOGRAPHIC INSTITUTIONS FOR DEEP EARTH 
SAMPLING (JOIDES)

Columbia University, Lamont-Doherty Earth 
Observatory

Florida State University

Oregon State University, College of Oceanic and 
Atmospheric Sciences

Pennsylvania State University, College of Earth 

University of California, Santa Cruz

University of Florida

University of Hawaii, School of Ocean and Earth 
Science and Technology

University of Miami, Rosenstiel School of Marine 
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and Mineral Sciences

Rutgers, The State University of New Jersey, 
Institute of Marine and Coastal Sciences and 
Faculty of Arts and Sciences

Stanford University, School of Earth Sciences

Texas A&M University, College of Geosciences

University of California at San Diego, Scripps 
Institution of Oceanography

University of Michigan, College of Literature, 
Science, and the Arts

University of Rhode Island, Graduate School of 
Oceanography

University of South Florida, College of Marine 
Science

University of Texas at Austin, Institute for 
Geophysics

*At time of publication. See Publisher’s Notes, p. 5, for list of funding agencies at time of cruise. For an up-to-date list of
current member organizations and office contact information, see the ODP Web site: www.oceandrilling.org.

http://www.nsf.gov/
http://www.oceandrilling.org/
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University of Washington, College of Ocean and 
Fishery Sciences

Woods Hole Oceanographic Institution

Australia/Canada/Chinese Taipei/Korea 
Consortium for Ocean Drilling: Department of 
Primary Industries and Energy (Australia), 
Natural Resources Canada, National Taiwan 
University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

European Science Foundation Consortium for 
Ocean Drilling (Belgium, Denmark, Finland, 
Iceland, Ireland, Italy, The Netherlands, Norway, 
Portugal, Spain, Sweden, and Switzerland)

Federal Republic of Germany, Bundesanstalt für 

OCEAN DRILLING PROGRAM (ODP)

Web site: www.oceandrilling.org

ODP SCIENCE ADVISORY STRUCTURE 
(JOIDES)

JOIDES Office
University of Miami—RSMAS
4600 Rickenbacker Causeway
Miami FL 33149, USA
Tel: (305) 361-4668; Fax: (305) 361-4632
E-mail: joides@rsmas.miami.edu
Web site: joides.rsmas.miami.edu
Geowissenschaften und Rohstoffe

France, Institut National des Sciences de 
l’Univers–Centre National de la Recherche 
Scientifique (INSU-CNRS)

Japan, University of Tokyo, Ocean Research 
Institute

People’s Republic of China, Marine High-
Technology Bureau of the State Science and 
Technology Commission of the People’s 
Republic of China

United Kingdom, Natural Environment Research 
Council 

ODP PROGRAM MANAGER

Joint Oceanographic Institutions, Inc.
1755 Massachusetts Avenue, NW, Suite 700
Washington DC 20036-2102, USA
Tel: (202) 232-3900; Fax: (202) 462-8754
E-mail: joi@joiscience.org
Web site: www.joiscience.org

http://www.oceandrilling.org/
mailto:joides@rsmas.miami.edu
http://joides.rsmas.miami.edu
mailto:joi@joiscience.org
http://www.joiscience.org
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ODP SCIENCE OPERATOR

Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station TX 77845-9547, USA

ODP SITE SURVEY DATA BANK

Lamont-Doherty Earth Observatory
of Columbia University

PO Box 1000, 61 Route 9W
Palisades NY 10964, USA
Tel: (979) 845-2673; Fax: (979) 845-4857
E-mail: odp@odpemail.tamu.edu
Web site: www-odp.tamu.edu

ODP LOGGING SERVICES OPERATOR

Borehole Research Group
Lamont-Doherty Earth Observatory 
of Columbia University

PO Box 1000, 61 Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8341; Fax: (845) 365-3182
E-mail: borehole@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/BRG/ODP

Tel: (845) 365-8542; Fax: (845) 365-8159
E-mail: odp@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/databank

mailto:odp@ldeo.columbia.edu
mailto:odp@odpemail.tamu.edu
http://www-odp.tamu.edu/
mailto:borehole@ldeo.columbia.edu
http://www.ldeo.columbia.edu/BRG/ODP
http://www.ldeo.columbia.edu/databank
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104 Ocean Administration Building
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104 Ocean Administration Building
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mailto:trehu@coas.oregonstate.edu
mailto:gbohrmann@geomar.de
mailto:frack@joiscience.org
mailto:mtorres@coas.oregonstate.edu
mailto:nathan@utig.ig.utexas.edu
mailto:srb7@leicester.ac.uk
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for responding to these challenges with efficiency and good humor. We are also grateful to the 

Catermar crew for ensuring a pleasant working environment.

The co-chief scientists would like to thank all the shipboard scientists, who worked so hard to make 
the leg a success. George Claypool deserves special mention for bringing his long-term expertise on 
methane in the seafloor and on issues related to drilling safety in this environment. We thank the ODP 
publications staff for their skill, patience, and hard work in producing this volume.

We wish to acknowledge the financial and logistical support from the many member countries of the 
Ocean Drilling Program. In addition, this cruise benefitted from support for new technologies from the 
U.S. Department of Energy and the European Union–funded HYACINTH program. The U.S. National 
Science Foundation and the NOAA Underwater Research Program provided support for essential 
precruise site survey data. 

Finally, we thank Vern Kulm and Erwin Suess for their pioneering research on the vent systems of 
Cascadia.
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CD-ROM CONTENTS: CHAPTERS

1. Leg 204 Summary
Shipboard Scientific Party

2. Explanatory Notes
Shipboard Scientific Party

3. Site 1244
Shipboard Scientific Party

4. Site 1245
Shipboard Scientific Party

5. Site 1246
Shipboard Scientific Party

6. Site 1247
Shipboard Scientific Party
7. Site 1248
Shipboard Scientific Party

8. Site 1249
Shipboard Scientific Party

9. Site 1250
Shipboard Scientific Party

10. Site 1251
Shipboard Scientific Party

11. Site 1252
Shipboard Scientific Party
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs) and smear slide and thin section data tables are included in this 
section. ASCII versions of the smear slide data tables are also available (see “ASCII Tables”). 

Site 1244
Visual Core Descriptions · Smear Slides 

Site 1245
Visual Core Descriptions · Smear Slides · Thin Sections

Site 1246
Visual Core Descriptions · Smear Slides 

Site 1247

Visual Core Descriptions · Smear Slides 

Site 1248
Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1249
Visual Core Descriptions · Smear Slides 

Site 1250
Visual Core Descriptions · Smear Slides

Site 1251
Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1252
Visual Core Descriptions · Smear Slides 
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of all of the smear slide data tables presented under “Core 
Descriptions.” A complete listing of the ASCII tables can be found listed below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 

menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program but not directly 
from PDF files.

Smear slide data tables
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Smear Slide Data Tables
Site 1244 smear slide table.
Site 1245 smear slide table.
Site 1246 smear slide table.
Site 1247 smear slide table.
Site 1248 smear slide table.
Site 1249 smear slide table.
Site 1250 smear slide table.
Site 1251 smear slide table.
Site 1252 smear slide table.
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 204 Site Map 

ODP Map (Legs 100–204)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 
A CD-ROM containing processed logging data and a subset of core data is included with the printed 
version of this volume. However, a more complete set of the logging data collected by ODP Logging 
Services is available online at www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html. If 
you have problems downloading the data, wish to receive additional logging data, or have questions 
regarding the data, please contact: Data Services Manager, ODP Logging Services, Borehole Research 
Group, Lamont-Doherty Earth Observatory of Columbia University, PO Box 1000, 61 Route 9W, 
Palisades NY 10964, USA; Tel: (845) 365-8343; Fax: (845) 365-3182; E-mail: 
logdb@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

http://www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html
mailto:logdb@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu


29

COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–178, 180, 183, and 186. The indexes are 
contained in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). 
These indexes can be searched individually or collectively.
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

204IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR204_01.PDF (Leg 204 Summary)VOLUME
(Leg 204 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(ASCII version of information about the volume CD-ROM)

MAPS
(Drilling location maps)

ODPMAP.PDF (ODP map, Legs 100 through 204)

CHAPTERS
(Volume chapters)

204_MAP.PDF (Leg 204 site map)

IR204_02.PDF (Explanatory Notes)

IR204_03.PDF (Site 1244)

IR204_04.PDF (Site 1245)

IR204_05.PDF (Site 1246)

IR204_06.PDF (Site 1247)

DSDPMAP.PDF (DSDP map, Legs 1 through 96)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the 
Leg 204 Initial Reports)

COR_1244.PDF (Site 1244)CORES
(Visual core descriptions, smear
slide and thin section data tables,
and digital core images)

COR_1245.PDF (Site 1245)

COR_1246.PDF (Site 1246)

IMAGES (PDF files of core images)

IR204_07.PDF (Site 1248)

IR204_08.PDF (Site 1249)

COR_1247.PDF (Site 1247)

COR_1248.PDF (Site 1248)

COR_1249.PDF (Site 1249)

MAC

UNIX

WINDOWS

IR204_09.PDF (Site 1250)

IR204_10.PDF (Site 1251)

IR204_11.PDF (Site 1252)

COR_1250.PDF (Site 1250)

COR_1251.PDF (Site 1251)

COR_1252.PDF (Site 1252)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 178NDX.PDF, 
180NDX.PDF, 183NDX.PDF, and 186NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

TABLES
(ASCII versions of smear slide data
tables)

S_SLIDES (Sites 1244 through 1252)

README.TXT
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